
 

 

 

 

  
  

 
 

 
 

    
 

   
 

        
 
 
       

 

 

  
           

  
 
               

                                           
                                               

 
 

 

 
 
 
  

Laboratory Procedure Manual 


Analyte: Desethyldesisopropylatrazine (DCZ), 
Desisopropylatrazine (SIS), Desethylatrazine (DTZ), 
Atrazine (AAZ), Desisopropilatrazine mercapturate
(SISM), Atrazine mercapturate (ATZ) 

Matrix:  Urine 

Method: Atrazine-related Metabolites in Urine 

Method No: 6107.03 

Revised: 08/24/2013 

As performed by: 
Organic Analytical Toxicology Branch 
Division of Laboratory Sciences 
National Center for Environmental Health 

Contact: 
   Dr. Liza Valentín-Blasini 

Phone: 770-488-7902 
              Email: lbv5@cdc.gov

             James L. Pirkle, M.D., Ph.D. 
          Director, Division of Laboratory Sciences 

Important Information for Users 
The Centers for Disease Control and Prevention (CDC) periodically refines these laboratory 
methods. It is the responsibility of the user to contact the person listed on the title page of 
each write-up before using the analytical method to find out whether any changes have 
been made and what revisions, if any, have been incorporated.  



 

 
 

 
 

 

 

  

  

  

  

  

  

 

File Name 
Variable 

Name 
SAS Label 

URXAAZ Atrazine 
URXATZ Atrazine mercapturate (ug/L) 

UAM_E 
URXDCZ Diaminochloroatrazine(ug/L) 
URXDTZ Desethyl atrazine(ug/L) 
URXSIS Desisopropyl atrazine(ug/L) 

URXSISM Desisopropyl atrazine mercapturate(ug/L) 



 

 
 

 

 

 
 

 
 

  
 

 

 

 

 

 

 
 

 
 

  
 

 
 

 
   
   

 

Clinical Relevance and Summary of Test Principle 
Atrazine (6-chloro-N-ethyl-N’-(1-methylethyl)-1,3,5-triazine-2,4-diamine; CAS Number: 
1912-24-9; AAZ) is a triazine herbicide used to kill weeds, primarily on crops such as 
sugarcane, corn, pineapples, sorghum, and macadamia nuts. It has also been used on 
evergreen tree farms, evergreen forest re-growth, highway and railroad rights-of-way, and 
turf application. Atrazine was the most used active ingredient in agriculture in the United 
States for nearly two decades, until it was replaced by glyphosate (EPA 2012).   

Atrazine enters into the environment, particularly soil and water. Its primary degradation 
can occur via soil bacteria and abiotic processes with an environmental half-life of a few 
weeks to several months (ATSDR 2003, Mandelbaum et al., 1993). Atrazine and its 
degradation products tend to migrate out of the soil into water systems including surface 
runoff to streams, river, and lakes, or deep ground water systems and aquifers (ATSDR 
2003) creating a potential for human exposure 

The atrazine metabolism may differ based on the exposure scenario (Barr et al. 2007). 
Occupational exposures may result in increased exposure to atrazine itself while 
environmental exposures are likely dominated by the dealkylated environmental 
degradates which are presumed to be biologically active if they retain the chlorine atom. 
Thus, measurement of multiple potential metabolites is preferable to best assess 
exposures to atrazine and its related degradates. 

The method uses solid phase extraction coupled with high performance liquid 
chromatography-tandem mass spectrometry (SPE-HPLC-MS/MS) for quantifying atrazine 
and several of its metabolites and/or hydrolysis products (Kuklenyik et al. 2012).  The 
method relies on automated off-line SPE to pre-concentrate the target compounds while 
reducing or eliminating most of the urine matrix potential interferences to increase 
sensitivity and specificity (Kuklenyik et al. 2012). Off-line SPE is coupled with on-line two-
dimensional (2D) HPLC combining cation exchange (SCX) and reversed phase (RP) 
chromatography in one integrated HPLC system followed by isotope dilution tandem mass 
spectrometry for the quantitative determination of the target analytes.   

1. Safety Precautions 

a. Reagent Toxicity or Carcinogenicity 
Some reagents used in this procedure are toxic. Avoid inhalation of or dermal exposure 
to these reagents. Consult the chemical hygiene plan specific for the pesticide 
laboratory if any questions about special precautions arise.    

b. Radioactive Hazards
 None 

c. Microbiological Hazards 
The possibility of exposure to various microbiological hazards exists. Take 
appropriate measures to avoid contact with the specimen (see “Protective equipment” 
below. A hepatitis B vaccination series is recommended for laboratorians who are 
exposed to human fluids and tissues. Observe universal precautions. Laboratory 



 

 
 

 

 

 
 

 

 
 

 

 
 

 

 

 

 

  

 

 

 

personnel handling human fluids and tissues are also required to take the 
“Bloodborne Pathogens Training” course offered at CDC to insure proper compliance 
with CDC safe work place requirements. 

d. Mechanical Hazards 
Follow standard safety practice while performing this procedure to minimize the risk 
for mechanical hazard. Avoid any direct contact with the electronic components of the 
mass spectrometer unless all power to the instrument has been shut off. Generally, 
only qualified technicians perform electronic maintenance and repair of the mass 
spectrometer. Contact with the heated surfaces of the mass spectrometer should be 
avoided; also, care must be taken to avoid puncture wounds from the corona discharge 
needle when removing the APCI interface. 

e. Protective Equipment 
Use standard personal protective equipment when performing this procedure. Wear a 
lab coat; safety glasses; and appropriate gloves. Use a chemical fume hood when 
preparing the reagents. 

f. Training 
Anyone performing this procedure should be trained and experienced in the use of an 
automated solid phase extraction and HPLC systems, and a triple-quadrupole mass 
spectrometer. Although formal training is not necessary, personnel are appropriately 
trained by an experienced operator of the instrument. All instrument operators must 
also read all operation manuals. 

g. Personal Hygiene 
Use caution when handling any biological specimen. Be sure to use gloves and wash 
hands properly. 

h. Disposal of Wastes 
Always dispose of solvents and reagents in an appropriate container clearly marked 
for waste products, and temporarily store them in a flame-resistant cabinet or 
equivalent storage space (follow CDC’s guidelines entitled Hazardous Chemical 
Waste Management). Use caution when handling containers, glassware, etc., that 
come in direct contact with the specimens. Decontaminate sample preparation 
surfaces with 10% bleach. Wash the glassware or dispose of it in an appropriately 
labeled autoclave pan. To insure proper compliance with CDC requirements, 
laboratory personnel are required to take annual hazardous waste disposal training 
courses. 

2. Computerization; Data-System Management 

a. Software and Knowledge Requirements 
A database named Starlims was developed on the CDC internal network. This 

database is used to store, retrieve, and analyze data generated at the Contemporary 
Pesticides Laboratory. The Statistical Analysis System (SAS)® software package is 
used to maintain the data-management structure.  



 

 
 

 

 
  

 

 

 
 

      

 

 
 

  
 

 
          
  

b. Sample Information 
Sample information can be retrieved from the database (Starlims). This includes 
sample-identification (ID) number, the notebook number associated with the sample 
preparation, the sample type, the standard number, and any other information not 
associated with the mass-spectral analysis. All sample information will electronically 
be transferred onto mass spectrometer-related-software upon sample analysis. 

c. Data Maintanance 
After uploading all sample and analytical data into the database, check for transcription 
errors and overall validity. The database is on the CDC network which is backed up 
regularly. 

3. Procedures for Collecting, Storing, and Handling Specimens; Criteria for Specimen 
Rejection 

a. Sample Handling 
Use standard urine collection cups to collect urine specimens from participants. 
Samples should be refrigerated as soon as possible. Preferably at least 10 mL of urine 
should be transferred into polypropylene vials or Qorpak® vials with screw-cap tops. 
Samples are subject to labeling, and are stored at or below -20˚C. Dry ice should be 
used for shipping. Carefully pack vials to avoid breakage during shipment. Store all 
samples at or below -20˚C until analysis. 

b. Sample Rejection 
Reject specimens with insufficient volume if they cannot be reliably processed.  

4. Procedures for Microscopic Examinations; Criteria for Rejecting Inadequately 
Prepared Slides 

Not applicable for this procedure. 



 

 
 

  

 

 
 

 
 
 

  

5. Preparation of Reagents, Calibration Standards, Controls, and All Other Materials;    
Equipment and Instrumentation 

a. 	Reagents and Sources 


Analytes nomenclature and structures 




 

 
 

 
 

 
 

 
 

 
 

 

 

 

  

   

 

 

 

 

 

 

  

Table 1: Calibration Standards, Reagents and their Manufacturers 

Solvents and other reagents of similar specifications but from other sources may also 
be used. 

Reagents Manufacturers 

Atrazine (10mg)    AAZ AccuStandard 
(New Haven, CT, USA) 

Atrazine D5  (100ppm) AAZ-L EQ Laboratories 
(Augsberg, Germany) 

Atrazine Mercapturate (100ppm)   ATZ Cambridge Isotope laboratory 
(Andover, MA, USA) 

Atrazine Mercapturate (100ppm)  (Ring 
13C3) ATZ-L 

Cambridge Isotope laboratory 
(Andover, MA, USA) 

Atrazine-desethyl (10mg) DTZ AccuStandard 
(New Haven, CT, USA) 

Atrazine-desethyl D6 (100ppm)  DTZ-L EQ Laboratories 
(Augsberg, Germany) 

Atrazine-desethyl-desisopropyl (10mg) DCZ  AccuStandard 
(New Haven, CT, USA) 

Atrazine-desethyl-desisopropyl (Ring-13C3)   
DCZ-L 

Cambridge Isotope laboratory 
(Andover, MA, USA) 

Atrazine-desisopropyl  (10mg) SIS AccuStandard 
(New Haven, CT, USA) 

Atrazine-desisopropyl D5 (100ppm)  SIS-L EQ Laboratories 
(Augsberg, Germany) 

Atrazine-desisopropyl Mercapturate SISM Cambridge Isotope laboratory 
(Andover, MA, USA) 

Atrazine-desisopropyl Mercapturate (Ring­
13C3) SISM-L 

Cambridge Isotope laboratory 
(Andover, MA, USA) 

Methanol Fisher Scientific 

Ammonium hydroxide Fisher Scientific 

Formic Acid, MS grade  98% (1000mL) Sigma-Aldrich Corp. 

Deionized water NANOpure Dlamond 
Barnstead 

Ammonium Acetate (500g) Sigma-Aldrich Corp. 

Argon Gas (99.99%) Airgas, Inc.  



 

 
 

 

 

 

 
 

 

 
 

 

 

 

 

 
      

   

 

 
 

 

 
 

b. Reagent Preparation 

Prepare as necessary. 

1) Liquid Chromatography Mobile Phases 

Mobile Phase A (pump 1 & 2) = ~0.5% formic acid in deionized water (v/v). This 
solution is prepared by adding 10 mL of formic acid into 2.0L of deionized water 
and mixing well. 

Mobile Phase B (pump 1 & 2) = ~20mM ammonium acetate in deionized water. 
This solution is prepared by dissolving 3.08g of ammonium acetate in 2.0L of 
deionized water and mixing well. 

Mobile Phase D (pump 2) = ~0.1% ammonium hydroxide in methanol (v/v). This 
solution is prepared by adding 1 mL of ammonium hydroxide into 1.0L of methanol 
and mixing well. 

2) Sample Clean-up Reagents 

2%formic acid in water (v/v) aqueous solution: The preparation is done by adding 
20 mL of formic acid into 980 mL of water (store refrigerated). 

1%formic acid in water (v/v) aqueous solution: The preparation is done by adding 
10 mL of formic acid into 990 mL of water (store refrigerated).  

~2% ammonium hydroxide in methanol (v/v): The preparation is done by adding 
2 mL of ammonium hydroxide into 100 mL of methanol (prepare fresh).  

c. Standards Preparation 

1) Stock Solutions of Analytes  
Prepare the individual stock solutions of commercially available neat standards by 
dissolving them in acetonitrile. Store the stock solutions in freezer safe vials below 
0˚C. 

2) Stock Solutions of Labeled Isotope Standards 
Prepare the individual stock solutions of commercially available neat standards by 
dissolving them in acetonitrile. Store the stock solutions in freezer safe vials below 
0˚C. 

3) Labeled Isotope (ISTD) Spiking Solution 
Prepare the spiking solution of isotope-labeled standards in 1:1 methanol: water. 

4) Native Spiking Standard Solutions 



 

 
 

 

 
 

 

 
 

 
 

 
 

      
 

 

 

 
   

 

 

 
 

 

Prepare ten working standard solutions of all target analytes in 1:1 methanol: water 
from the individual stock solutions. The final concentrations from a 20-µL spike 
would cover a range of 0.05 ng/mL to 50 ng/mL. 

5) Calibration Verification Materials  
CLIA defines calibration materials as "a solution which has a known amount of 
analyte weighed in or has a value determined by repetitive testing using a reference 
or definitive test method."  According to this definition, our quality control (QC) 
materials qualify as calibration verification materials. 

6) Proficiency Testing Materials 
Proficiency testing materials are matrix-based samples (typically spiked samples) 
with a known or characterized concentration.  These samples may be spiked or 
have endogenous levels of the target analytes. 

d. Equipment/Supplies 

1) Sartorius Ultramicro® Microbalance (Westbury, NY) 

2) Electronic 6-channel pipette (Rainin Instrument Company, Oakland, CA) 

3) 450 µL pipette tips (TOMTEC, Hamden, CT) 

4) EDP2® pipettes (Rainin Instrument Company, Oakland, CA) 

5) Presterilized filter pipette tips (Rainin Instrument Company, Oakland, CA) 

6) Vortex Genie® vortex mixer (Scientific Industries Inc., Springfield, MA) 

7) 96-well plates (2 ml square well, Varian, Lake Forest, CA) 

8) 96-well format cartridges 60 mg Strata-X-C polymeric SCX (Phenomenex,
 

Torrance, CA) 
9) Luna 5u SCX 100A Guard Column 30 x 4.6 mm (Phenomenex, Torrance, CA) 
10) Gemini 5u C6-Phenyl 100x4.6 mm Column(Phenomenex, Torrance, CA) 
11) Luna 5 µm SCX 100 Å 50 x 4.6 mm Column (Phenomenex, Torrance, CA) 
12) TOMTEC Quadra3 automated SPE station (Hamden, CT) 
13) Turbovap 96 concentration workstation (Caliper Life Sciences, Hopkinton, MA) 
14) NANOpure Infinity ultrapure water system 
15) Qorpak bottles (Lab Depot, Inc., Cumming, GA) 

e.Instrumentation 

The 2D HPLC system is constructed in-house by use of Agilent 1200 modules (Agilent 
Technologies, Waldbronn, Germany), specifically two quaternary pumps (Pump I and 
II) with built in degassers, one autosampler, three external ten-port switching valves 
(Valve I, II, and III), and one column compartment with a six-port valve (Valve D) 
(Kuklenyik et al. 2012).  A high-pressure mixing T is also incorporated between Valves 
II and III to allow for in-line mixing with an aqueous 0.5% formic acid flow provided by 
Agilent 1100 isocratic pump, Pump T (Agilent Technologies, Waldbronn, Germany); 
Pump T is turned on/off from the autosampler by contact closure signals. The solvent 
gradients, switching valves movements, and contact closures are controlled by the 



 

 
 

 
 

 

 

 
 

 
 

 
     

 

 
 

 
 
 

 

 
 

 
 

Chemstation B.04.02 SP1 software (Agilent Technologies). Sample separation is 
performed using this 2D HPLC system and three HPLC columns (Phenomenex, 
Torrance, CA): Luna SCX (30 mm × 4.6 mm, 5 µm p.s.), Gemini C6-Phenyl RP (100 
mm × 4.6 mm, 5µm p.s.), and Luna SCX (100 mm × 4.6 mm, 5µm p.s.). 

Mass spectrometry analysis is performed on a TSQ Vantage mass spectrometer 
(ThermoFisher, San Jose, CA) equipped with an atmospheric pressure chemical 
ionization (APCI) interface to generate gas phase ions of the target analytes. The mass 
spectrometer is programmed and controlled using Xcalibur software (ThermoFisher, 
San Jose, CA). The APCI is set in the positive ion mode with the multiple reaction 
monitoring (MRM) setup. 

The HPLC and MS/MS systems are operated from separate computers, and they 
communicated only through a contact closure circuit. 

6. Calibration and Calibration Verification Procedures 

a. 	  Calibration Plot 
1) 	 Construct a calibration plot using ten calibration standards by performing a linear 

regression analysis of relative response ratio factor (i.e., area native/area label) 
versus standard concentration. 

2) The lowest point on the calibration curve is at or below the calculated limit of 

detection (LOD) and the highest point is above the expected range of results. 


3) Determination of the slope and intercept of this curve is by linear least squares fit 

using Xcalibur software. 

4) 	 R2 values for the curve must be greater than 0.98. Linearity of standard curves 
should extend over the entire standard range. Intercepts, calculated from the least 
squares fit of the data, should not be significantly different from 0; if they are, the 
sources of this bias need to be identified. 

b.     Calibration Verification 
1) Calibration verification is not required by the manufacturer(s) of the HPLS­

MS/MS system. However, it should be performed after any substantive changes 
in the method or instrumentation (e.g., new internal standard, change in 
instrumentation), which may lead to changes in instrument response, have 
occurred. 

2) All calibration verification runs and results shall be appropriately documented. 
3) According to the updated CLIA regulations from 2003 

(http://www.cms.hhs.gov/CLIA/downloads/6065bk.pdf), the requirement for 
calibration verification is met if the test system’s calibration procedure includes 
three or more levels of calibration material, and includes a low, mid, and high 
value, and is performed at least once every six months. 

4) All of the conditions above are met with the calibration procedures for this 
method. Therefore, no additional calibration verification is required by CLIA. 

c. 	Proficiency Testing 

http://www.cms.hhs.gov/CLIA/downloads/6065bk.pdf


 

 
 

 

 

 

 

 

 

 
 

 

 
 

 

 
 
 

Proficiency testing should be performed a minimum of once approximately every 6 
months. Because no formal PT testing program exists for the target analytes of this 
method, an in-house program is used.  This in-house program currently includes 
pools prepared in-house but could include independently prepared materials whose 
preparation was contracted out to an external laboratory.  Where applicable, NIST 
matrix-based certified reference materials may be included as PT materials. Once 
the in-house PT pools are characterized, their mean concentration and standard 
deviation are forwarded to a DLS representative responsible for executing the PT 
program (PT administrator).  These PT samples are blind-coded by the PT 
administrator and returned to the laboratory staff for storage. Approximately every six 
months, the laboratory supervisor or his/her designee will notify the PT administrator 
who will randomly select five PT materials for analysis. The selected PT materials will 
be analyzed in the same manner as unknown samples.  These PT materials will 
be selected from among four different concentration ranges spanning the linear range 
of the method. The concentration range for each sample will be blinded to all 
analysts. Following analysis, the results will be forwarded to the PT administrator for 
evaluation. A passing score is obtained if at least four of the five samples fall within 
the prescribed limits established by the PT administrator. The PT administrator will 
notify the laboratory chief or his/her designee of the PT results (i.e. pass/fail).  If a PT 
challenge is failed, a second attempt to demonstrate proficiency by analyzing a 
second set of PT samples is undertaken. If the second attempt fails, laboratory 
operations will cease until an appropriate corrective action is taken.  After correction 
action is taken, laboratory operations can resume. All proficiency results shall be 
appropriately documented. 

7. Operating Procedures; Calculations; Interpretation of Results  

a. Analytical Runs 
A typical analytical run consists of 36 unknown/study urine samples (total of 72 in one 
96-well plate), four quality control (QC) samples (two low-concentration QC [QCL] 
and two high-concentration QC [QCH], so a total of 8 QCs in one 96-well plate), a 
blank (total of 2 in one 96-well plate), and nine calibration standard samples.  Remove 
unknown samples and QC materials from storage freezer and allow them to come to 
room temperature prior to preparation.    

b. Sample Preparation 

In a 96-well plate (2 ml square well, Varian, Lake Forest, CA), 1 mL aliquots of urine 
and QCs are spiked with 20 L of internal standard solution. Reagent blanks and 
calibration standards are prepared by adding 20 L of internal/calibration solutions to 
each well. Then the 96-well plate is placed on a TOMTEC Quadra3 automated SPE 
station (Hamden, CT). Study samples, QCs, reagent blanks, and calibration 
standards are processed by use of the same automated procedure. A 96-well format 
cartridge bed (60 mg Strata XC polymeric SCX packing with 1.5 mL liquid space, 
Phenomenex, Torrance, CA) is conditioned with 2×430 L of HPLC-grade methanol 
and 2×430 L of 2% formic acid in water. Several of the target analytes are acid­



 

 
 

 

 

 

 

 
 

 

 

 
   

 

 

    
    
  

 

 
 
 

 
    

 

 

    
    

     
   
   
   
   
   
   
   

 
 

 
 

 

labile. Therefore, to minimize their exposure to the required acidic media for the 
optimal performance of the method, 2×430 L of 2% formic acid in water is added to 
each sample well and pipette-mixed twice right before loading the urine onto the SPE 
cartridge. After sample loading (6×310 L), the cartridges are washed with 2×430 L 
of 2% formic acid in water. The target analytes are eluted with 3×400 L of freshly 
prepared ~2% NH4OH in MeOH. The eluted samples in the second half of the 96-well 
plate are transferred to a clean 96-well plate and all the SPE extracts (two partially 
occupied 96-well plates) are evaporated to ~20 µL under a stream of dry nitrogen 
(UHP grade) at 50 ºC in a Turbovap 96 concentration workstation (Caliper Life 
Sciences, Hopkinton, MA). The evaporated SPE extracts are reconstituted only right 
before the injection into the HPLC system by use of the Agilent 1200 HPLC 
autosampler (Agilent Technologies, Wilmington, DE), programmed to add 80 µL 1% 
formic acid in water to each SPE extract. During the sample analysis, the autosampler 
is kept at 4ºC by using an Agilent 1200 thermostat module. 

c. 	Liquid Chromatography Conditions 
The HPLC separation uses a stepwise-gradient elution as shown in Table 2 and Table 
3 to maximize the resolution of target compounds against their matrix interferences.   

Table 2: HPLC Separation – Pump I 

Time (min) Flow Rate 
(mL/min) 

%A %B %C 

0.00 0.200 30.0 30.0 40.0 
12.00 0.200 30.0 30.0 40.0 
13.00 1.000 0.0 0.0 100.0 
15.00 1.000 0.0 0.0 100.0 
15.50 0.200 95.0 0.0 5.0 
20.00 0.200 95.0 0.0 5.0 

Table 3: HPLC Separation – Pump II 

Time (min) Flow Rate 
(mL/min) 

%A %B %C %D 

0.00 0.500 95.0 0.0 5.0 0.0 
1.00 0.500 80.0 0.0 20.0 0.0 
1.01 1.000 70.0 10.0 20.0 0.0 
4.00 1.000 70.0 10.0 20.0 0.0 
5.00 1.000 40.0 30.0 30.0 0.0 
7.00 1.000 40.0 30.0 30.0 0.0 
7.25 1.000 20.0 30.0 50.0 0.0 
13.00 1.000 20.0 30.0 50.0 0.0 
14.00 1.000 0.0 20.0 80.0 0.0 
16.00 1.000 0.0 20.0 80.0 0.0 
16.50 1.000 0.0 0.0 0.0 100.0 
18.00 1.000 0.0 0.0 0.0 100.0 
18.50 1.000 95.0 0.0 5.0 0.0 
20.00 1.000 95.0 0.0 5.0 0.0 



 

 
 

 
 
 

 

  
 

 

  

 

 
 

  
 
  

 

 

 
  

1) Sequence Setup 
Open Chemstation; Instrument 1 (Online) 
 To create a sequence: Choose Sequence > Sequence Table 
 Manually define the following necessary parameters;  

Vial Position→ Enter each individual sample vial position 
Method Name → Enter the selected method 
Injection per Location → Enter 1 
Injection Volume → Enter 10 µL 

     To Save Sequence: Choose Sequence > Save Sequence, then identify 
sequence name. 

2) Run the sequence 

 To open a sequence: Click Sequence > Load Sequence 

 Choose specific sequence and then click OK 

 Then click Sequence > Sequence Table
 
 On the bottom of the Sequence Table, Click Run Sequence 

 Click the “OK” button when ready to proceed
 

d. Mass Spectrometer Conditions 
Configuration parameters for this instrument are found in Table 4. The 
optimized precursor/product ion pairs, as well as the collision off-set energy 
and the retention time for the target compounds, are summarized in Table 5. 



 

 
 

 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 

                       
 

 

 

   

 

 

  

  

  

  

  

  

   

   

   

   

 
 

 

 

  

 

 

 

Table 4: MS Configuration 

MS Parameter Setting 

Ionization Type APCI 

Ion Polarity Mode positive ion 

Discharge Current 4.0 µA 

Vaporizer Temperature 400˚C 

Collision Gas Pressure 1.5 torr 

Sheath Gas Pressure 25 

Auxiliary gas 5 

Capillary Temperature 260˚C 

Table 5: Select HPLC-Mass Spectrometry Parameters 

Analyte Precursor ion; (M+H)+ 

(m/z) 

Product ion (Confirmation ion) 

(m/z) 

Retention time 

(min) 

DCZ 146 79 (104) 4.3 

SIS 174 68 (104) 8.6 

DTZ 188 104 (146) 10.2 

AAZ 216 174 (104) 15.1 

SISM 301 172 (102) 12.3 

ATZ 343 214 (172) 15.3 

DCZ-L 149 113 4.3 

SIS-L 179 101 8.6 

DTZ-L 194 104 10.1 

AAZ-L 221 179 15.1 

SISM-L 305 172 12.3 

ATZ-L 346 217 15.2 

1) Sequence Setup 



 

 
 

  
 
 

 

    
  

 

  
   

 
   

 
  

 
 

 

 
 
   

 
 

  
                 

 
  

 
  
 
    
    

 
 

 
   

 

Open Xcalibur; Xcalibur allows importing data created by the Starlims database 
 To import a sequence: Choose File > Import Sequence 

 Use the Browse button to select the file for import. 

 Select all sequence columns to be included in the sequence file.  

 Click on OK to import the sequence: Xcalibur displays the imported file in 


Sequence Setup 
	 Manually define the following parameters;  

File name→ Enter each individual sample file name 
Path → Enter the directory path where the sample’s raw file will be stored;  
Inst. Meth → Enter the directory of the instrument method file  
Comments (If needed) 

     To Save File: Choose File > Save As 

2) Run the sequence 
  Click on the Run Sequence Icon on the tool bar. 
 Check to make sure that the selected rows are displayed in the Run 

Sequence dialogue Box. 
 Click Instrument Setting to “Standby” after the sequence has been run at 

the bottom of the Run Sequence dialogue Box. 
   Click the “OK” button when ready to proceed. 

e. Processing data 
To process a batch of samples: 

  Save all selected raw files and sequence file onto a removable drive. 
   Transfer all data onto desktop PC used for data processing 
 Specific sequence associated with target raw files has to be modified by 

identifying “Level” “Path” and “Processing Method” prior data 
processing 

  Open Quan® browser and select the modified sequence  
  Click Process button 

f. Quantification 
	 After processing the sample batch, visually evaluate for correct peak 

detection and baseline selection in the Quan® browser. If needed, correct 
integrations and/or peak selection manually 

 To save the settings in a Quan Browser file (*.XQN). Choose File>Save As 
 Export data files to EXCEL® using the long report format 
 To export data files to EXCEL® → File > Export Excel > Long Report 
 Quan Browser allows the operator to view quantitative results, to evaluate 

standard curve, QCs and unknowns samples, to integrate chromatogram 
peaks manually, and to analyze detailed quantification information. 

g. Rearrangement of Data Files 
Data are automatically rearranged into a multiple worksheet (Excel format) ® that is 
compatible with the Division’s database, Starlims, using an Excel® macro. 



 

 
 

 
 

               
 

  

 

 
 

 

 

 

 

 
 

  

   
 

 
 

 
 

 
 

 

 
 

 

h. 	 Transfer of Data
     Data are transferred using CDC approved McAfee Encrypted USB removable drive. 

i. 	 Importation of Data into Database 
Select “Import new data” option in database.  A password is required to import the 
data. 

j. 	Statistical Analysis and Interpretation of Data 
Data are exported from the Starlims database into SAS.  SAS programs for QC 
evaluation have been created by the Division statisticians and may be executed in 
SAS when this information is needed. 

k. 	 Routine and Periodic Maintenance of Key Components 
The instrumentation used is serviced according to the manufacturer’s guidance 
included in the instrument manuals or based on the recommendation of experienced 
analysts/operators after following appropriate procedures to determine that the 
instrument performs adequately for the intended purposes of the method. 

Mass Spectrometer  

Preventive maintenance (PM) is required every 6 months and it is performed by 
a Thermo Service Engineer. Instrument inspections, testing, cleaning and part 
replacements are done according to the manufacturer guidelines. Open vacuum 
manifold, cleaning of the Q0, Q1, Q2 and Q3 quadrupoles should only be done 
by a Thermo Service Engineer. All maintenance records are kept electronically 
in the instrument computer. 

In general, the maintenance procedures of calibration and cleaning API stack (ion 
sweep cone, tube lens, skimmer and Q00) are performed by the operator if there 
is a decrease in the system performance (sensitivity or S/N ratio) without any 
other apparent technical reasons. 

Clean corona needle with sand paper followed by water and methanol, as 
needed. 

Clean the ion transfer tube as needed. Use metal needle to check for internal 
blockage; if internal blockage exists, discard ion transfer tube and use a new one. 
If not, clean ion transfer tube by sonicating in 30% HNO3 in water (v/v) for about 
30 minutes, then in methanol and in acetone (for about 15 minutes in each 
solvent). 

The frequency of cleaning the components of the mass spectrometer depends 
on the type and number of samples analyzed and solvents used. 

Agilent 1200 HPLC-Systems 



 

 
 

 

 
 
  

 
 
  

 
                     

 

 

 
 

 
 

 
 
 

  

Systems undergo annual routine maintenance by service technicians. All 
maintenance records are kept electronically in the instrument computer.   

The HPLC systems require a few simple maintenance procedures to keep them 
in optimum working condition. 

Check the solvent tubing and connections for leaks. 
Back-flush or change analytical column as necessary (when peak tailing or 
high pressure is observed).  
Replace HPLC filter as needed. 
Check needle position into vials & sample wells. 
Ensure that the solvent reservoir contains sufficient running solvent for all 
samples. 

8. Reportable Range of Results 
The linear range of the standard calibration curve and the method LOD determine 
the highest and lowest analytical values of an analyte that are reportable. The 
reportable range must be within the range of the calibration curves.   

a. Linear Limits 
Analytical standard curves are linear for all analytes through the range of 
concentrations evaluated. The high linearity limit is determined by the highest 
standard analyzed. The low end of the linear range is limited by the method 
LOD. Concentrations below the method LOD are reported as non-detectable. 
Samples with concentrations exceeding the highest calibration standard are 
re-extracted using less urine. The lowest calibration point should be at or below 
the LOD and the highest calibration point has to be above the expected range 
of results for most samples. The linear range for all target analytes is from 
LOD to 50 ng/mL. 

b. Analytical Sensitivity 
The LODs are presented in Table 6. 



 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

 

 
 

  

  

  

 

 

 

 
 

 

 

 

  

  

  

 

 

 

Table 6: Method Detection Limits 

Analyte LOD 
(ng/ml) 

DCZ 0.50 

SIS 0.25 

DTZ 0.25 

AAZ 0.50 

SISM 0.10 

ATZ 0.50 

c. 	Accuracy 
The accuracy of this method is defined as the degree of agreement between 
the mean of measured concentrations of samples and their nominal values 
(measured/expected). Accuracy is shown in Table 7. 

Table 7: Accuracy of the Method 

Analyte 

%Accuracy (measured/expected) 

Low Level High Level 

DCZ 96 101 

SIS 97 99 

DTZ 95 97 

AAZ 94 100 

SISM 87 99 

ATZ 99 99 

d. Precision 
The precision is determined by calculating the coefficient of variation (CV) of 
repeat measurements (n=40) of quality control materials at two concentrations 
and includes all sources of variability (Table 8).   



 

 
 

 
 

 
 

 

 

                   
 

 

 

 

 

 

 

 
 

 

 
 

 

 

 

 

Table 8: Precision of the Method 

Analyte 
%CV 

QCL QCH 
DCZ 4 3 

SIS 4 4 

DTZ 8 7 

AAZ 4 3 

SISM 2 4 

ATZ 4 3 

e. 	Analytical Specificity 
This is a highly selective method that requires the following of each analyte 
detected: 1) that it elutes at a specific retention time, 2) that it has one 
precursor ion at a specific mass, 3) that it has two specific product ions formed 
from each precursor ion at specific masses, and 4) that the ion ratios of the 
two product ions are within a predetermined range. 

9.    Quality Control (QC) Procedures 

a. 	 Individual samples (i.e., standards, unknown  samples, and quality control (QC) 
materials) QC procedures 

i. 	 The relative retention time (RT) (ratio of RTanalyte and RTIS) of standards, unknowns, 
and QCs should be within 0.90 ~ 1.10.  If the relative RT falls outside the range, 
check the RT(s) of the peaks of analyte and IS to make sure the program picked the 
correct signals for integration. 

ii. 	 The area counts of IS for each analyte should meet minimum requirements. Low IS 
area count could indicate strong ion suppression from sample matrix, or simply 
missing of IS (i.e., error in spiking).  Depending on the findings, either re-extract the 
original sample or dilute the sample first and re-extract it.    

iii.	 Using the current method, all standards, blanks, QCs and study samples are 
prepared by the same procedure, thus the background is automatically subtracted 
from unknown levels and represented as the intercept of the calibration curve. If the 
background levels are consistently high, the reagents used for sample preparation 
and (or) mobile phases need to be checked for potential contamination.  

iv. 	 The ratio of the calculated concentration of quantitation ion (Q1) and the calculated 
concentration of confirmation ion (Q2) for a given analyte should follow the same 
ratio (Q1/Q2) for the standards and QCs for the same analyte. 



 

 
 

 
 

 

 

 

 
 

 

 

 

 

 
 

 
  

v. 	 When sample (A+1) run after a sample (A) which contained a high concentration of 
any given analyte (e.g., ~ ppm levels), sample (A+1) might have to be repeated to 
eliminate the possibility of carryover.  If the calculated carryover amount (0.05 % x 
concentration of sample A) is greater than 30% of the calculated concentration of 
sample (A+1), sample (A+1) needs to be reanalyzed. 

vi. 	 If a given analyte concentration in a study sample is above the highest calibration 
standard, the sample needs to be re-analyzed with a smaller urine volume. 

b. Analytical batch quality control procedures 

a. QC Materials 
Urine pools enriched with known amounts of pesticides residues as the control 
material should be analyzed in each analytical run. QC materials for each analytical 
run are aliquoted at the same time when samples are prepared. 

b. 	 Collection of Urine for QC Pools 
Collect urine from multiple anonymous donors, and screen the urine to ensure that 
the endogenous levels of pesticide residues are low or non-detectable. Combine 
and homogenize the urines (~24 hrs) to form a base pool. The protocol for 
anonymous collection of urine to prepare QC pools was reviewed and approved by 
CDC’s Institutional Review Board.  

c. Filtration and Dispensing 
The urine pool is pressure filtered with a 0.45-m filter capsule. Mix with 1:1 water 
and homogenize well ~24 hrs. 

d. Urine Enrichment 
Take two equal pools (~500 ml) from the base pool and reserve the rest for later 
use at or below -10C. Enrich one of the pools with an appropriate amount of the 
stock solution of each pesticide residue to yield an approximate concentration of 
5.0 ng/mL (QCL) and enrich the other pool to yield an approximate concentration 
of 10 ng/mL (QCH). Mix the individual pools thoroughly (~24hrs), aliquot in to 2.2 
mL portions and store at or below -20C until use. 

e. Characterization of QC Materials 
Characterize the QC pools by analyzing them at least on 20 separate runs (2 
from each level per run for 20 measurements). Use the data from these runs 
to establish the mean and both upper- and lower- 99% and 95% control limits. 



 

 
 

 

 

 
 

 

 

 

 

 

   

    
 

 

 
 

 

     

 

 

 

 
 

f. Use of QC Samples 
During each analytical run, four QC materials (two from each QCL & QCH 

levels) are analyzed together with unknown samples. The average value of
 
the paired QCH and QCL samples is evaluated to determine a run either in-

control or out-of-control. 


g. Final Evaluation of Quality Control Results 
The results of the QC materials analyzed with the study samples are evaluated 
according to standard Westgard multi-rule criteria (Caudill et al. 2008) to determine 
a run either in-control or out-of-control. No data from runs considered out-of-control 
will be reported. 

When using 2 QC pool levels per run, the rules are: 

For 1 QC result per pool 

1) If both QC run results are within 2Si limits, then accept the run. 
2) If 1 of the 2 QC run results is outside a 2Si limit - reject run if: 
    Extreme Outlier – Run result is beyond the characterization mean  4Si

 1 3S Rule – Run result is outside a 3Si limit 
2 2S Rule – Both run results are outside the same 2Si limit 

10 X-bar Rule – Current and previous 9 run results are on same side of the 
characterization mean 

R 4S Rule – Two consecutive standardized run results differ by more than 4Si 

(standardized results are used because different pools have different means). 
Since runs have single measurements per pool for 2 pools, comparison of results 
for the R 4S rule will be with the previous result within run or the last result of the 
previous run. 

For 2 or more QC results per pool 

1) If both QC run means are within 2Sm limits and individual results are within 2Si
 

limits, then accept the run. 

2) If 1 of the 2 QC run means is outside a 2Sm limit - reject run if: 

    Extreme Outlier – Run mean is beyond the characterization mean  4Sm

 1 3S Rule – Run mean is outside a 3Sm limit 
    2 2S Rule – Both run means are outside the same 2Sm limit 

10 X-bar Rule – Current and previous 9 run means are on same side of the 
characterization mean 

  3) If one of the 4 QC individual results is outside a 2Si limit - reject run if: 
R 4S Rule – Within-run ranges for all pools in the same run exceed 4Sw (i.e., 
95% range limit). Since runs have multiple measurements per pool for 2 pools, 
the R 4S rule is applied within runs only. 

Abbreviations: 

Si = Standard deviation of individual results (the limits are not shown on the chart 
unless run results are actually single measurements). 



 

 
 

 

 

 

 
 

 

 

 

 

 

 

 
 
 

 

 

 

Sm = Standard deviation of the run means (the limits are shown on the chart). 
Sw = Within-run standard deviation (the limits are not shown on the chart). 

10.   Remedial Action If Calibration or QC Systems Fail to Meet Acceptable Criteria 
If the calibration or QC systems fail to meet acceptable criteria, suspend all operations 
until the source or cause of failure is identified and corrected. Check for any 
irregularities (e.g., low calibration curve regression coefficient, change in calibration 
curve slope or intercept, high reagent blank concentration, low internal standard 
sensitivity). If the source of failure is easily identifiable, for example, a pipetting error, 
correct the problem immediately. Otherwise, prepare fresh reagents and clean the 
mass spectrometer system. Before beginning another analytical run, re-analyze several 
QC materials (in the case of QC failure) or calibration verification samples (in the case 
of calibration failure). After re-establishing calibration or QC, resume analytical runs. 

11. 	  Limitations of Method; Interfering Substances and Conditions 
This method is an isotope-dilution mass spectrometry method, which is widely 
regarded as the definitive method for the measurement of organic toxicants in 
human specimens. By using tandem mass spectrometry, a large number of 
analytical interferences are eliminated. However, because of the urinary matrix 
used in this procedure, occasional interfering of unknown substances has been 
encountered. Interferences with the internal standards result in rejection of that 
analysis. If a repeat analysis still results in an interference with the internal 
standard, do not report the results for that analyte. 

12. 	 Reference Ranges (Normal Values) 
Reference range values are not available 

13. 	  Critical-Call Results (“Panic Values”) 
Insufficient data exist to correlate urinary concentrations of this pesticide or its 
metabolites with serious health effects in humans.  Therefore, critical call values 
have not been established. 

14. Specimen Storage and Handling during Testing 
All samples and standards must remain frozen prior to use. Stability studies 
suggest that the analytes are stable up to four days at room temperature after 
preparation (at neutral pH but not at acidic pH) (Kuklenyik et al. 2012).  

15. 	  Alternate Methods for Performing Test and Storing Specimens If Test    
  System Fails 
The method is designed to run on an LC-MS/MS instrument and is not 
transferable to other instrumentation. If the system fails during the injection, 
samples have to be re-prepared. If the system fails before reconstitution with 1% 
formic acid solution, the urine extracts can be stored up to four days at -70 C. 

16. 	 Test-Result Reporting System; Protocol for Reporting Critical Calls  



 

 
 

 

 

 

 
 

 
 

 
 

 

  

  

a. 	The data from analytical runs of unknowns are initially reviewed by the laboratory 
supervisor. The supervisor provides feedback to the analyst and/or his/her 
designee and requests confirmation of the data as needed. 

b. The Quality Control officer reviews each analytical run and identifies the quality 
control samples within each analytical run and determines whether the analytical 
run is performed under acceptable control conditions. 

c. 	One of the Division statisticians reviews and approves the quality control charts 
pertinent to the results being reported.  

d. If the quality control data are acceptable, the laboratory supervisor or his/her 
designee generates a memorandum to the Branch Chief, and a letter reporting the 
analytical results to the person(s) who requested the analyses to be signed by the 
Division Director. 

e. 	 The data are sent (generally electronically by e-mail) to the person(s) that made the 
initial request. 

f. 	 All data (chromatograms, etc.) are stored in electronic format. 
g. Final hard copies of correspondence are maintained in the office of the Branch Chief 

and/or his/her designee and with the quality control officer. 

17. Transfer or Referral of Specimens; Procedures for Specimen Accountability and 
Tracking 
Use standard record-keeping systems (i.e., notebooks, sample logs, data files, 
creatinine logs, demographic logs) to keep track of all specimens. Transfer of 
CLIA-specimens is only permitted to certified laboratories.  

Use of trade names is for identification only and does not imply endorsement by the Public Health 
Service or the U.S. Department of Health and Human Services. 

18. Summary Statistics and QC Graphs 

See following pages 



2007-2008 Summary Statistics and QC Chart for Atrazine in urine 
 

Lot N 
Start 
Date 

End 
Date Mean 

Standard 
Deviation 

Coefficient of 
Variation 

1646 63 24SEP13 03JUL14 13.16111 0.54532 4.1 
1644 63 24SEP13 03JUL14 6.70857 0.26252 3.9 
1646 12 25SEP13 09MAY14 12.96250 0.39550 3.1 
1644 12 25SEP13 09MAY14 6.53458 0.35026 5.4 

 

 
 

 



2007-2008 Summary Statistics and QC Chart for Atrazine mercapturate 
 

Lot N 
Start 
Date 

End 
Date Mean 

Standard 
Deviation 

Coefficient of 
Variation 

1646 63 24SEP13 03JUL14 16.24762 0.58007 3.6 
1644 63 24SEP13 03JUL14 8.19754 0.30428 3.7 
1646 12 25SEP13 09MAY14 15.93750 0.66610 4.2 
1644 12 25SEP13 09MAY14 8.17208 0.27041 3.3 

 

 
 

 



2007-2008 Summary Statistics and QC Chart for Diaminochloroatrazine 
 

Lot N 
Start 
Date 

End 
Date Mean 

Standard 
Deviation 

Coefficient of 
Variation 

1646 63 24SEP13 03JUL14 14.52063 0.56495 3.9 
1644 63 24SEP13 03JUL14 7.20119 0.29065 4.0 
1646 12 25SEP13 09MAY14 14.19583 0.97897 6.9 
1644 12 25SEP13 09MAY14 7.17042 0.41729 5.8 

 

 
 

 



2007-2008 Summary Statistics and QC Chart for Desethylatrazine 
 

Lot N 
Start 
Date 

End 
Date Mean 

Standard 
Deviation 

Coefficient of 
Variation 

1646 63 24SEP13 03JUL14 10.64460 0.63456 6.0 
1644 63 24SEP13 03JUL14 5.27476 0.37479 7.1 
1646 9 25SEP13 09MAY14 10.43389 0.70681 6.8 
1644 9 25SEP13 09MAY14 5.26278 0.36695 7.0 

 

 
 

 



2007-2008 Summary Statistics and QC Chart for Desisopropyl atrazine 
 

Lot N 
Start 
Date 

End 
Date Mean 

Standard 
Deviation 

Coefficient of 
Variation 

1646 63 24SEP13 03JUL14 14.44206 0.90830 6.3 
1644 63 24SEP13 03JUL14 7.16429 0.44059 6.1 
1646 8 25SEP13 09MAY14 13.43125 0.84892 6.3 
1644 8 25SEP13 09MAY14 6.89438 0.45339 6.6 

 

 
 

 



2007-2008 Summary Statistics and QC Chart for Desisopropyl atrazine mercapturate 
 

Lot N 
Start 
Date 

End 
Date Mean 

Standard 
Deviation 

Coefficient of 
Variation 

1646 63 24SEP13 03JUL14 6.83214 0.26924 3.9 
1644 63 24SEP13 03JUL14 3.40643 0.11724 3.4 
1646 9 25SEP13 17APR14 6.79944 0.31591 4.6 
1644 9 25SEP13 17APR14 3.39889 0.13160 3.9 
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